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Introducing ArcGIS Tracking Analyst 1
• Tracking temporal data

• Symbolizing temporal data

• Displaying data

• Charting temporal data

• Creating and applying actions

• Tips on learning Tracking Analyst
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Tracking temporal data
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Symbolizing temporal data
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Displaying data
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Charting temporal data
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Creating and applying actions
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Tips on learning Tracking Analyst
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Finding answers to questions
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Getting help on your computer
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Contacting ESRI
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ESRI education solutions
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Quick-start tutorial 2
���������"���������������������
���������������������� �����!�������������
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-� 2������ �����%���������� ������������6<<<!�-� �"�����%%�������������
������������ �����.����"��� �"����������%���������������������%����������
���������%���!�������� 2��� �������
������������������������������������
� ��������"��������"��%����������������%�������������������!

• Exercise 1: Adding and symboliz-
ing temporal data

• Exercise 2: Replaying temporal
data

• Exercise 3: Applying actions
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Adding a shapefile or feature class
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Exercise 1: Adding and symbolizing temporal data
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14 USING ARCGIS TRACKING ANALYST

Symbolizing temporal data

�������������
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������"��������������������� �%�������������������

��*��������������������!�
���������������� �"�����������
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16 USING ARCGIS TRACKING ANALYST

-� 2��������%����������� ������������% ��������������.���
%���������%������������������������������������ %�����������
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��"������������������
��*��������������������!����
�����"���������% ����������� ����� ���������������
��������������%���� ���������'��������*������!

Replaying symbolized temporal data

������������� �������������� 2�����%�����%����������%���2�
�����������%����%������%������������������������������!
E�"��� 2��� �������'��������*���������������������%������
������ ���%!��������'��������*���������� �����������������%
��%���������������������"��%�"����%�����������������������%
�������������������%�"��������� �"��������%����������������
�������� � ������!�;��������������������������������������
'��������*���������� ���������������: ������������� ����
��%����������������������������������
������2���������)
��������������!

>! ,���������'��������*�������� ��������������������

��������������!�����'��������*������������!

6! ,�����G����������������� ������"��������%���������!

=! ,���������
������������"��%�"����������������������
%���%�"������"���%�������6<<<A������"�����������
���������%������������ �� ����%%�%!

Exercise 2: Replaying temporal data

E���#���������������%� ����������������%���%�������������
���������"��%�"�������� %����������������������������������
%������������������%����������������!������ �������%%�%�����
��������������������������� ����������������������������0
��������%���%������0���������������������������������������
����������������� �����������������!

?! ,���������'�������������%���%�"������"���%�������
1����������� ���!

@! ,���������'����� ����!�����'��������*��������������
��������%������������������������������������%�����%���
���������������������������!

B! ����� �"����������%���������%������������� ����������
9�%��9���������������"�����'��������*�������"���� �
�������������!

-� ���������%� ��������"�%�"����������������������
�����������%�%����������������%���%�����������������������
����'��������*��������������
��"������;�������������!
,���������/��������������������������%���������� � ���!

��������������������������������'��������*����������"�
������� ������%����������������������������������������
���������������!�-� ����������������
������	�%����%

�

�

�� � �
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, ����������������������������%���%�"������"������%�������
����%�������� ����������������������%������%�������%������%�����
���������%�������!

����� �"�������� %�������������������"��%��������"��%
"�����������������%������� ������������������E������%
'����� ��� �����������������������������������!������
� �������%� �������� ������%����������%�������%���������
�����������%��������%������������������������� �����
�%� ����������%�������������%� ������������%������!�-� ����
����� �������E������%�'����� ��� ������"���������������
%���!

-� �����������������%����%���������������������%�%�������
�����������%���������������������������������������������
�������"�����"��������������������������� ����������!

E���#������ ������������%�������������������������"�������
%������������������"������ ���������%�%������������
��%���������������������������������������������!
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18 USING ARCGIS TRACKING ANALYST

Exercise 3: Applying actions

-� ��������������%��������������������"���������������%���2�
%��������������������!�������������"���������������� �"���
������������������������������"���������������%�������������
���������%����������% �������������!�-� �"���������
������������������
��������.��%����������������� �������2�
�����"���������������������%������������"��%�����%!

Creating a highlight action for playback

������������� �������������� ��������%��� ���������.�%�%���
 ���������'��������*������!��������������������� �"�����%%
�������������������� ���������������������������"��%
����%�����D@�������%�������!�-� �"���� �������
�������������
����/�����'����������%��������������������������������!

>! �����)����������6<<<A��������������%����������������
��������������������%�������'���������!

6! ,���������
������������������/�����'����������%���������!

=! ,�����E�"�
�����!

����E�"�
������%���������������!

?! ,��������������������%������I"��%����%J��������������
����������!

@! ,�����9���������C�
 �������������������������
��������
,������ �����!

B! ,�����GH!

����9���������C�
 ����������
������'����������%�����
���������!

D! /��������������%���%�"��%��� ������9��������!

5! ,���������9���������
������� �����������������
��*��

������
��������%���������!

�

�

�

�

�
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>>! ,���������
����� ���8 ����� ����!

>6! ,�����8 ����4 ��%��!

>=! ,�����/��%���������������G����%���������!

F! 
������%�"����%�������������������������������������!
������%� ���������.���������G�������������������������!

><! ,�����GH!

��������������������������9���������
������� �������
����9���������C�
 ����������
������'����������%�����
���!

�
�
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20 USING ARCGIS TRACKING ANALYST

>?! ,��������%����%������� ���!������������������%�������%��
��%�������G���!

>@! ,�����
��������������������"������� ���: �����������%���
�����!

>B! ,�����,����!

E���#�������������������� 2������%��������������������������!
�����������������%����2�������%����������� ��������� ���� �
�"������������� ��������������������������%���������!

�

�

�

�

>D! ,�����GH��������'����������%���������!

������"�����������������������������������������
������
���!

E���#�-� ��������������������������������������������������
�����%��������� ������������
������1�����������������������
�����������������!

>5! ,�����GH!

�
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>F! ������� ����������������	��������6����� ������'�������
*���������%����"��������������� 2�����%��������
�����������������!

�������������������"����������������������������������������
��������"�������������% ��������������� ���������������������
��������!���������������%�������"������������� �������
������%���"��%�����%����D@��������������!
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Working with temporal data 3
• What is temporal data?

• Simple and complex temporal
events

• Adding temporal data in ArcMap

• Adding a tracking shapefile from
ArcView GIS 3.x

• Complex data

• Using temporal layer properties

• Displaying the most current
temporal event

• Setting temporal offset for a layer

• Saving and exporting data in
ArcMap

������������������ �"������������������������"�������"�������������%���� ����
���������
������������% �������
��,���������%�
��*��!�-� �"�������������
������� ������"��%������ ����������.������%���� �� ��������������������!

-� �"������������"���#

$ G�����.��������������������%����������%���!

$ 
%%����������%�������
��*��!

$ 
�����%���������������������������������!

$ 
������%�����������������%���!
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What is temporal data?
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Simple and complex temporal events
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Complex dynamic events
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ID Geometry Type ...

1 X1,Y1
Model #

200

2 X2,Y2 Model #
200

3 X3,Y3
Model #

300

4 X4,Y4 Model #
300

ID Time Status Value
1 T1 Active 100
2 T2 Active 80
1 T3 Active 100
2 T4 Active 110
3 T5 Active 90
2 T6 Inactive 0
4 T7 Active 100
1 T8 Active 100
1 T9 Inactive 0

Temporal Object Table Temporal Observation Table

ID Geometry Type ...

1 X1,Y1
Model #

200

2 X2,Y2 Model #
200

3 X3,Y3
Model #

300

4 X4,Y4 Model #
300

ID Time Status Value
1 T1 Active 100
2 T2 Active

ID Geometry Type ...

1 X1,Y1
Model #

200

2 X2,Y2 Model #
200

3 X3,Y3
Model #

300

4 X4,Y4 Model #
300

ID Time Status Value
1 T1 Active 100
2 T2 Active 80
1 T3 Active 100
2 T4 Active 110
3 T5 Active 90
2 T6 Inactive 0
4 T7 Active 100
1 T8 Active 100
1 T9 Inactive 0

Temporal Object Table Temporal Observation Table
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Adding complex events from fixed-time data
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ID Type Airline ...
1 747 United
2 727 American
3 747 United
4 767 United

ID Time Status
1 T1 Green
2 T2 Green
1 T3 Green
2 T4 Green
3 T5 Green
2 T6 Yellow
4 T7 Green
1 T8 Green
1 T9 Red

Geometry
X1,Y1
X2,Y2
X3,Y3
X4,Y4
X5,Y5
X6,Y6
X7,Y7
X8,Y8
X9,Y9

Temporal Object Table Temporal Observation Table

ID Type Airline ...
1 747 United
2 727 American
3 747 United
4 767 United

ID Time Status
1 T1 Green
2 T2 Green
1 T3 Green
2

ID Type Airline ...
1 747 United
2 727 American
3 747 United
4 767 United

ID Time Status
1 T1 Green
2 T2 Green
1 T3 Green
2 T4 Green
3 T5 Green
2 T6 Yellow
4 T7 Green
1 T8 Green
1 T9 Red

Geometry
X1,Y1
X2,Y2
X3,Y3
X4,Y4
X5,Y5
X6,Y6
X7,Y7
X8,Y8
X9,Y9

T4 Green
3 T5 Green
2 T6 Yellow
4 T7 Green
1 T8 Green
1 T9 Red

Geometry
X1,Y1
X2,Y2
X3,Y3
X4,Y4
X5,Y5
X6,Y6
X7,Y7
X8,Y8
X9,Y9

Temporal Object Table Temporal Observation Table

Table join for a complex dynamic temporal event
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Adding temporal
data in ArcMap
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Accessing the Tracking
Analyst toolbar
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Enabling the extension
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Adding a shapefile or
feature class

1. Click the Add Temporal Data
Wizard button on the Track-
ing Analyst toolbar.

On the wizard, the first button
is selected by default, which
will browse for a shapefile
(.shp) or feature class. Leave
it at the default setting.

2. Click the Browse button and
choose the shapefile or
feature class you want.

3. Navigate to the desired
shapefile or feature class,
highlight it, and click Add.

The file’s pathname appears
in the wizard. Default values
appear in the Date/Time and
Track ID text boxes.

4. Click the date/time field
dropdown arrow and choose
the appropriate field.

5. Click the track ID dropdown
arrow and click the appropri-
ate ID field from the list.

Note: Click None if you’re
adding discrete events such
as lightning strikes.

An ID field is required if you
want to apply tracks, labels,
and the most current setting.

6. Click Finish to add the layer
to ArcMap. �
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28 USING ARCGIS TRACKING ANALYST

Tip

Adding temporal data as a
layer file (.lyr)
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The layer appears in the
table of contents with a
default base symbol and an
All Time label, and the data
appears on the map.
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WORKING WITH TEMPORAL DATA 29

Adding a tracking
shapefile from
ArcViewGIS 3.x

1. Open a background .mxd file
in ArcMap.

2. Click the Add Temporal Data
Wizard button on the
Tracking Analyst toolbar.

3. Click the Browse button to
navigate to the tracking
shapefile you wish to import.

Note: A tracking shapefile
from ArcView GIS 3.x will
already contain temporal and
track identifier information.
This procedure converts the
file into a feature class to
make it more compatible with
ArcGIS Tracking Analyst.

4. Navigate to the file you want,
highlight it, and click Add.

The wizard changes to
indicate the file’s identifier
field.

5. Click Browse to navigate to a
geodatabase where the new
feature class will reside.

Note: If a geodatabase
doesn’t already exist, you
can create one in
ArcCatalog. See Using
ArcCatalog for more informa-
tion.

6. Click on the geodatabase
you wish to contain the new
feature class and click Add. �

Adding a tracking
shapefile from
ArcView GIS 3.x
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30 USING ARCGIS TRACKING ANALYST

A progress bar appears at
the bottom of the wizard,
indicating the status of the file
conversion.

7. Click Finish.

The new feature class
appears in ArcMap as a new
layer, both on the map and in
the table of contents.

�
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WORKING WITH TEMPORAL DATA 31

Adding complex
temporal data

1. Click the Add Temporal Data
Wizard button on the Track-
ing Analyst toolbar.

2. Click A feature class and a
separate table containing
temporal data that this wizard
will join to the feature class
button.

3. Click the Browse button and
navigate to the geodatabase
(.mdb) you want. Click Add.

4. Highlight the input features
component and click Add.

5. Click the Browse button and
choose the input table.

Note: Make sure the table
resides in the same
geodatabase as the feature
class you just selected.

6. Highlight the table you want
and click Add.

Its path and filename appear
in the wizard, and the Date/
Time Format buttons and
dropdown lists are enabled
with default values. �
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Creating a feature class
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32 USING ARCGIS TRACKING ANALYST

7. Click the button beside the
appropriate input file contain-
ing the date and time
information—either the input
feature class or the input
table.

8. Click the date/time format
dropdown arrow to choose
the appropriate date and time
field if it does not appear
automatically.

9. Click Next.

10. Click the Join Field in Input
Feature Class dropdown
arrow and choose the
appropriate field to perform
the join.

11. Click the Join Field in Input
Table dropdown arrow, and
choose the appropriate field
to perform the join.

12. Click Finish.

A message appears on the
wizard that the join
completed successfully. The
combined feature class
appears as a new layer in
ArcMap with a default layer
name and a label of All Time.

Once the new layer appears in ArcMap, you can edit the symbology .

Tip

Time Field for stationary and
dynamic complex events
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Using Join Field dropdown
lists
���������������
��������������
�������
������������
�
�	�
����

�������
��
���&�������
�
�	�
����

����������
������	�����
�	���	
�����
�
�����	������������������	���
��
��+����������	!�������	���
	���
��������������
�
�	�
������	��
���
�����
���
����	���
����,��
����
��������

���������

	

� �




�

�

Ch03_CMYK.p65 10/04/2002, 9:20 AM32



WORKING WITH TEMPORAL DATA 33

Using temporal layer properties
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Displaying the most current temporal event
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Using temporal offset
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Displaying the
most current
temporal event
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Enabling the most
current setting

1. Open an .mxd file and add
the temporal data you want
to display.

For more information on
adding data, see ‘Adding a
simple shapefile or feature
class’ or ‘Adding complex
temporal data’ in this chapter.

2. Double-click the temporal
data layer you wish to
display.

3. Click the Temporal tab in the
Layer Properties dialog box.

Show is highlighted in the
Settings panel.

4. Click Display only the most
current events in the layer.

Note: This setting will display
the most current event for
each ID—that is, each
unique object—in the
dataset. Previous events for
each ID will be hidden.

5. Click OK.

6. Use the Playback Manager
to display the data with the
new setting.

Tip

Using tracks with the most
current setting
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Setting an ID field
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Setting temporal
offset for a layer
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Setting temporal offset
for a fixed-time temporal
layer

1. Open an .mxd file and add
the temporal data you want to
offset.

2. Click the Symbology tab in
the Layer Properties dialog
box to apply temporal
symbology to the layer.

3. Right-click the layer you want
to offset and click Properties
on the context menu.

4. Click the Temporal tab in the
Layer Properties dialog box.

5. Click Temporal Offset.

Three buttons become active.

6. Click Use a duration to offset
the data.

7. Click Past or Future for the
offset.

8. Click the text box and type
“365”.

9. Click the dropdown arrow
and choose Days for the
units.

10. Click the Color for offset line
in histogram button and
choose a color for the offset
line that will appear in the
Playback Manager.

11. Click OK to accept changes
and close the dialog box.�
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WORKING WITH TEMPORAL DATA 37

12. Click the Playback Manager
button on the Tracking
Analyst toolbar.

13. Change playback settings as
desired and click the Play
button to replay the data.

Tip

Adding and symbolizing
temporal data
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Saving and
exporting data in
ArcMap
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Saving a temporal layer
as a .lyr file

1. Right-click the layer you want
to save in the table of
contents.

2. Click Save As Layer File from
the Context menu to open the
Save Layer dialog box.

3. Navigate to the desired folder
and click Save.

The file is saved with the
layer name by default. You
can type a different name if
you prefer.

4. Add this layer to any map
using the ArcMap Add Data
button.

Note: If you have applied
actions to a layer that you
export as an .lyr file, the
applied actions will be read-
only in the resulting file.

Exporting a map

1. Click File and click Export
Map.

The Export window opens.

2. Navigate to the folder where
you want your image file and
choose the file format you
want to use from the Save as
type dropdown list.

3. Click Export to save the
image file.

Tip

Exporting a map
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Tip

Exporting an AVI file
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WORKING WITH TEMPORAL DATA 39

Exporting temporal data

1. Right-click the temporal layer
in the Table of Contents and
click Export Data on the
context menu.

The Export Data dialog box
opens.

2. Click the Export dropdown
arrow and choose All
features or All features In
View Extent.

Note: If you have selected
features in the layer, you can
also choose Selected
features.

3. Click the appropriate button
to either use the same
coordinate system as the
layer’s data source or use the
same coordinate system as
the data frame.

4. Click the Browse button and
navigate to the destination
folder for the output shapefile
or feature class.

5. Click OK.

A message will appear,
asking if you want to add the
shapefile to the current map.

6. Click Yes to include the
output shapefile in the
current map document, or No
to save it without including it
on the map.

The new layer will be saved
as a temporal layer.
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Saving a map with
temporal data as an
ArcMap .mxd file

1. Click the Save button on the
ArcMap Standard toolbar.

Note: If the file has already
been saved, it will automati-
cally save the new informa-
tion to the same filename.
Otherwise, the Save As
window appears.

2. Navigate to the folder where
you want the finished .mxd
file to reside.

3. Click the Save As type
dropdown arrow, and choose
to save the map as an
ArcMap file (.mxd) or a
template (.mxt).

4. Type a name for the file in the
File name text box and click
Save.

Tip

Viewing tabular data
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Symbolizing temporal data 4
• About symbolizing temporal data

• Symbolizing point data

• Symbolizing line data

• Symbolizing polygon data

• Symbolizing a track
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About symbolizing temporal data
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Other display settings
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Symbolizing
point data
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Symbolizing point data
by color

1. Open a background .mxd file
and add the desired tempo-
ral data.

For more information on
adding temporal data, refer
to Chapter 3, ‘Working with
temporal data’.

When the temporal data is
initially added, its default
symbology appears in the
ArcMap table of contents,
showing default base
symbology and a label of All
Time.

2. Double-click the temporal
data layer in the table of
contents and click the
Symbology tab of the Layer
Properties dialog box.

The tab shows default base
symbology, and the Events
check box is checked in the
Show panel.

3. Click Events in the Show
panel and edit your base
symbol shape if you wish.

4. Click Apply to accept
changes and keep the
dialog box open.

5. Click the Time Window check
box in the Show panel.

6. Click Color in the Drawn As
panel to activate the color
ramp and other fields. �

Tip

Modifying the time window
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7. Click the Period dropdown
arrow and choose a numeric
value from the list or type a
numeric value in the field.

8. Click the Units dropdown
arrow and choose a unit from
the list.

9. Click the Color Ramp
dropdown arrow and choose
an appropriate color range.

10. Click the How dropdown
arrow under Classification
and choose a display option
for the data: Past, Future, or
Future & Past.

11. Click the Classes dropdown
arrow and choose a number
of time ranges from the list.

The legend panel updates
with each new setting.

12. Click in any of the Range or
Label fields in the legend
panel to manually change
values.

Note: Any manual changes
will be overwritten if you
continue to change display
settings on the tab.

13. Click OK.

The table of contents shows
the temporal and base
symbology for the data layer.
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Setting period and classes
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Using MOLE symbology
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Symbolizing point data
by size

1. Open an .mxd file and add
the desired temporal data.

For more information on
adding temporal data, refer
to Chapter 3, ‘Working with
temporal data’.

When the temporal data is
initially added, its default
symbology appears in the
ArcMap table of contents,
showing default base
symbology and an All Time
label.

2. Double-click the temporal
data layer in the table of
contents and click the
Symbology tab in the Layer
Properties dialog box.

3. Click the Time Window check
box in the Show panel.

4. Click Size in the Drawn As
panel.

5. Change the settings for
Period and Units as needed.

6. Click in the fields for Symbol
size and enter numeric
values to define the size
range for the symbols.

7. Click the How dropdown
arrow and choose Past,
Future, or Future & Past. �

Tip

Symbolizing points by size
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Editing the legend manually
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8. Click the Classes dropdown
arrow and choose a value.

9. Edit values in the legend
manually if you wish.

10. Click OK.

The table of contents in
ArcMap updates with the
changes you’ve made.

�
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�

Symbolizing point data
by shape

1. Open a background .mxd file
and add the desired tempo-
ral data.

For more information on
adding temporal data, refer
to Chapter 3, ‘Working with
temporal data’.

When the temporal data is
initially added, its default
symbology appears in the
ArcMap table of contents,
showing default base
symbology and a label of All
Time.

2. Double-click the temporal
data layer in the table of
contents and click on the
Symbology tab in the Layer
Properties dialog box.

The tab shows default base
symbology, and Events is
checked in the Show panel.

3. Click the Time Window check
box in the Show panel.

4. Click Shape in the Drawn As
panel.

5. Click the Period and Units
dropdown arrows to choose
desired values for these
settings.

6. Click the How dropdown
arrow and choose Past, Past
& Future, or Future. �

Tip

Adjusting the size of
shape-symbolized temporal
points
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Editing ranges and labels
manually
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7. Click the Classes dropdown
arrow and choose the
number of classes to appear
in the legend panel.

8. Double-click a symbol in the
legend panel to open the
Symbol Selector dialog box.

9. Scroll down and click the
shape you want, then click
OK.

The new symbol appears in
the legend panel.

10. Repeat steps 8 and 9 for
each range whose symbol
you want to change.

If you change any other
display setting, your symbols
will reset to the default.

11. Click OK.

The table of contents
updates to show the
changes you have made.
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Symbolizing line
data
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Symbolizing line data

1. Open a background .mxd file
and add the desired
temporal data.

For more information on
adding temporal data, refer
to Chapter 3, ‘Working with
temporal data’.

When the temporal data is
initially added, its default
symbology appears in the
ArcMap table of contents,
showing default base
symbology and a label of All
Time.

2. Double-click the temporal
data layer in the table of
contents to open the Layer
Properties dialog box.

3. Click the Symbology tab.

The tab shows default base
symbology, and Events is
checked in the Show panel.

4. Click the Time Window box
in the Show panel.

The No modification and
Color options appear in the
Drawn As panel.

5. Click Color in the Drawn As
panel.

6. Click the Period dropdown
arrow to select a numeric
value for your time window.

7. Click the Units dropdown
and choose a unit for the
time window. �
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8. Click the Color Ramp
dropdown to choose a color
scheme.

9. Click the How dropdown
arrow and choose to display
the data in a time window
that includes past, future, or
both.

10. Click the Classes dropdown
arrow and choose the
number of classifications you
want for the data.

11. Click in the legend panel
and manually change any
ranges or labels if you wish.

If you change the value of a
range, the subsequent
ranges will update
automatically.

Note: Any manual changes
to these values will be lost if
you return to other settings
on the Symbology tab.

12. Click OK.

The table of contents will
update with the new
symbology information you
have entered.

Note: After you have applied
a time window, data will not
appear on the map until you
open the Playback Manager.
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Symbolizing
polygon data
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Symbolizing polygon
data by color

1. Open an .mxd file in ArcMap
and add a temporal data
layer.

For more information on
steps for adding temporal
data, refer to Chapter 3,
‘Working with temporal data’.

2. Double-click on the temporal
data layer in the table of
contents to open the Layer
Properties dialog box.

3. Click the Symbology tab.

4. Click the Time Window check
box in the Show panel.

5. Click Color in the Drawn As
panel.

6. Click the Period dropdown
arrow and choose a numeric
value from the list, or type a
value in the field.

7. Click the Units dropdown
arrow and choose a value
from the list.

8. Click the Color Ramp
dropdown arrow and choose
an appropriate color range.

9. Click the How dropdown
arrow and choose Past,
Future, or Future & Past from
the list.

10. Click the Classes dropdown
arrow and choose an
appropriate value. �
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11. Click in any of the legend
fields to change ranges or
labels manually.

Note: Manual changes will
be lost if you continue to
alter display settings.

12. Click OK.

The table of contents
updates with the temporal
modifications you have
made.
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Symbolizing a
track
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Symbolizing tracks using
unique values

1. Right-click the temporal data
layer you want to symbolize
in the ArcMap table of
contents and click Properties.

2. Click the Symbology tab.

The tab appears with default
settings and no temporal
capabilities.

3. Click the Tracks check box in
the Show panel.

4. Click Unique values in the
Drawn As panel.

Note: Even though tracks
connect features with the
same ID, you can symbolize
unique values on any field in
the dataset.

5. Click the Value Field
dropdown arrow and choose
the field for which you want
unique values displayed.

6. Double-click the line symbol
in the center panel.

The Symbol Selector dialog
box opens.

7. Click the type of line you
want to use for the track and
click OK. �

Tip

Using a single symbol to
designate tracks
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8. Click the Color Scheme
dropdown arrow and choose
a color range for the tracks.

9. Click Add All Values.

The center panel will update
with the layer’s values for the
specified field, including their
new symbology.

10. Click OK.

The table of contents
updates with the track
symbology you have added.

�
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Time modes
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Using the playback histogram
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Displaying
symbolized
temporal data
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Displaying symbolized
temporal data

1. Click the Open button on the
ArcMap toolbar and choose
an ArcMap document (.mxd).

2. Add temporal data and edit
its desired symbology and
display properties.

For more information on
steps to add and symbolize
temporal data, refer to
Chapter 3, ‘Working with
temporal data’, and
Chapter 4, ‘Symbolizing
temporal data’.

3. Click the Playback Manager
button on the Tracking
Analyst toolbar.

4. Click Options to see detailed
settings in the dialog box.

5. Click the Set playback
window to temporal extent of
dropdown arrow and click the
extent you wish to include in
playback.

This setting defines the start
and end times of the play-
back window to include all of
the data in the selected layer
or layers.

6. Click the Playback Rate unit
dropdown arrow and choose
the appropriate playback
units from the list. �

Tip

Using temporal offset
during playback
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7. Click Options to make the
Playback Manager dialog box
smaller.

8. Click the Play button.

The Playback Manager dialog
box remains open, indicating
progress of the playback, and
the data begins to display
within the ArcMap window.

�

�
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Using the
Animation Wizard
��
�����������������������&
����������������������� ��
�
����� 
��� ���� ������������ ��
��	
������������8�:�����
�5
�����
� ���������������������

������5�������"��	��
�����
5
���
����������
����
���
������
���������������������
�
������:���
���(�����������
��
� 
���&���&
���� �������������
����� ����� ���� ���������

����
�

��
� �
�������� �
����
� 
�� �
�
���� ��� ������ ��
� ��
� ��������
�������� 
��� ���� ��� ����
�
��
����
��
���������� �

����� ��
������������������������� ���
��
��� +��� �������
�� ���� ���

��������"�����
�������
 ����
���
����������������
&���������������
����� ����
��
� ���� �

� ��

�
�������������� ��	���� ��� �
���
��
� �������
�

Using the Animation
Wizard

1. Open an ArcMap document
(.mxd).

2. Add temporal data and edit
its symbology as desired.

For steps to add and
symbolize temporal data,
refer to Chapter 3, ‘Working
with temporal data’, and
Chapter 4, ‘Symbolizing
temporal data’, respectively.

3. Click Tracking Analyst from
the Tracking Analyst toolbar,
then click Animation Tool.

Note: The default settings in
the Animation Wizard come
from the Playback Manager.

4. Click the Start Date
dropdown arrow and choose
a date from the popup
calendar, or type a start date
and time in the text box.

5. Click the End Date dropdown
arrow and choose a date
from the popup calendar, or
type an end date and time in
the text box.

6. Click in the Create a frame
every text box and type a
number of units to include
per frame.

7. Click the Create a frame
every dropdown arrow and
choose a unit from the list.

8. Click Calculate. �

�

� �
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Tip

Animation settings
�����
��	���
��������������
�����
������������7�	��	
�
�	
	����	���������	���������
����1��

	
�
�	
��������������
������
�����
�
��	���
�'��	���

Ch05.p65 10/02/2002, 3:07 PM67



68 USING ARCGIS TRACKING ANALYST

Note: If the number of frames
exceeds the system maxi-
mum, an error message will
appear. You can change
frame frequency or the start
and end times to reduce the
number of frames.

9. Click the Animation Format
dropdown arrow and choose
the frame or AVI engine to
generate the desired output.

10. Click Configure Engine.

11. Choose the type of frame
compression you want from
the dropdown list. Click OK.

Note: The default engine is
Full Frames (Uncompressed).

12. Click in the Width text box
and type a numeric value for
the width of the frames.

13. Click in the Height text box
and type a numeric value for
the height of the frames.

14. Click Maintain Aspect Ratio
to constrain the frame
proportions.

15. Click Save As. �

Tip

Minimizing AVI file size
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Saving output as
individual frames
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16. Navigate to the appropriate
folder and type a filename.
Click Save.

17. Click Generate.

As the Animation Wizard
generates an output file, the
Create Movie File dialog box
shows progress.

�

�
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Labeling
temporal data
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Applying labels to a
temporal data layer in
ArcMap

1. Open an .mxd file in ArcMap
and add and symbolize
temporal data as desired.

For steps to add and
symbolize temporal data, see
Chapter 3, ‘Working with
temporal data’, and
Chapter 4, ‘Symbolizing
temporal data’.

2. Double-click the temporal
layer you want to label.

3. Click the Labels tab in the
Layer Properties dialog box.

4. Click the Label Most Current
Features in this layer check
box.

This check box toggles label
display.

5. Click the Label Field
dropdown arrow and choose
the field whose text you want
to appear as the label.

6. Click Symbol to change the
font and style of the label text.

A preview of the label text
appearance is shown in the
Text Symbol panel.

7. Click the Label Placement
dropdown arrow and choose
where the label will display
relative to the feature.

8. Click OK.

Tip

Labels during playback
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Charting temporal data 6
• About charting temporal data

• Using the Data Clock

• Using the Data Clock Manager
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About charting temporal data
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The Data Clock chart
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Data summary methods
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Legend settings
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Data Clock Manager
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Using the Data
Clock
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Creating a data clock

1. Open an .mxd file in ArcMap
and add and symbolize
temporal data.

For steps to add and
symbolize temporal data,
refer to Chapter 3, ‘Working
with temporal data’, and
Chapter 4, ‘Symbolizing
temporal data’.

2. Click Tracking Analyst on the
Tracking Analyst toolbar.
Point to Data Clock and click
Create Data Clock.

3. Click the Choose layer to
chart dropdown arrow and
choose the temporal layer
you want to include in the
data clock.

4. Click the Choose summary
method to create data clock
dropdown arrow and choose
the method by which Tracking
Analyst will divide the data
for the chart.

5. Click the Choose number of
legend classes dropdown
arrow and choose a number
from the list.

6. Click the Choose color
scheme dropdown arrow and
choose the color range to
include in the data clock.

7. Click Finish.

The data clock chart opens,
showing the results of the
settings you’ve changed in
the wizard.

Tip

Choosing a summary method
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Using the Data
Clock Manager
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Modifying an existing
data clock

1. Open an .mxd file with
temporal data already added
and symbolized.

For steps to add and
symbolize temporal data, see
Chapter 3, ‘Working with
temporal data’, and
Chapter 4, ‘Symbolizing
temporal data’.

2. Click Tracking Analyst from
the Tracking Analyst toolbar.
Point to Data Clock and click
Manage.

The Data Clock Manager
opens, showing a list of data
clocks you have created.

3. Click the data clock you want
to modify and click Open.

The data clock chart opens.

4. Right-click anywhere in the
chart window and click
Properties.

Note: You can also use this
context menu to turn chart
labeling on or off and to
refresh the view.

5. Click the Appearance tab. �

Tip

Understanding the legend
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6. Change settings in the
appearance to adjust the
data clock chart title, the
colors and legend classes
used, and the placement and
display of the legend.

Note: Changing the title on
the Appearance tab will
effectively rename the data
clock in the Data Clock
Manager.

7. Click the Data tab.

8. Make changes to the settings
on the Data tab, including the
charting method, as needed.

9. Click OK.

The data clock chart updates
with the changes you have
made.
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Creating and applying actions 7
• Applying actions to temporal data

• Layer actions in ArcMap

• Applying filter actions in ArcMap
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Applying actions to temporal data
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Layer actions
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Layer actions in
ArcMap
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Applying a suppression
action to a layer

1. Right-click the desired
temporal data layer in the
table of contents and click
Properties.

2. Click the Actions tab in the
Layer Properties dialog box.

3. Click New Action.

The New Action dialog box
opens.

4. Type a name for the action.

If you choose not to enter a
name, the default, New
Action 1, will be used.

5. Click Highlight / Suppression
in the Type of Action to
Create panel.

6. Click OK.

The Highlight / Suppression
Action Parameters dialog
box opens.

7. Click the Type dropdown
arrow and click Suppression.

8. Click the button beside the
type of query you want to
use.

9. Click Query Builder.

Note: If Always or Location
Query is chosen, the Query
Builder button will be
disabled. �

Tip

Service actions
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10. Double-click a field in the
Fields panel on the left side
of the Query Builder dialog
box to place it in the
Expressions panel below.

11. Click the control or controls
you wish to use to set the
query conditions.

12. Enter a value for the field.

The query will look for this
value in the field you have
specified and perform the
action on any feature
meeting this criteria.

13. Click Apply.

14. Click Close.

The Highlight / Suppression
Action Parameters dialog
box remains open, showing
your attribute query
expression.

15. Click OK.

The new action appears in
the action list panel. You can
continue adding new actions
as you wish, editing the
order in which to apply them
using the Move Up and Move
Down buttons.

Note: You can disable or
enable any action in the
action list panel by clicking
its check box to the left.

Tip

Actions that stop further
processing
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Applying a filter action

1. Right-click the temporal data
layer you want to filter in the
table of contents and click
Properties.

2. Click the Actions tab.

3. Click New Action.

4. Click Filter as the Type of
Action to Create.

5. Click in the text box and type
a name for the filter action.

If you choose not to enter a
name, the default setting of
New Action will be used.

6. Click OK.

7. Click the Type dropdown
arrow and choose Include or
Exclude.

The Include filter will permit
only data that meets certain
location or attribute criteria
and exclude all other fea-
tures. Exclude will deny
features that meet the
criteria.

8. Click Always, Attribute Query,
Location Query, or Attribute
AND Location Query to set
the type of action trigger.

This example uses a location
query. For steps in creating
an attribute query, see
‘Applying a suppression
action to a layer’ earlier in
this chapter. �
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Changing action order
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9. Click the Layer dropdown
arrow and choose a layer
whose location will somehow
interact with the temporal
layer you’re working with.

10. Click the Trigger When
dropdown arrow and choose
a relationship between the
layer you’ve chosen and the
temporal layer—for example,
Intersects.

11. Click OK.

The new action appears in
the action list panel. If other
actions appear in the list,
you can use the Move Up
and Move Down buttons to
put them in the order in
which you want to apply
them to the data layer.

Note: You can enable or
disable any action in the list
by clicking on its check box
to the left.

Note: Applying an action will
stop processing of
subsequent actions in the list
for any feature meeting its
conditions.
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What is real-time data?
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Setting up a real-
time connection
in ArcCatalog
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Connecting to a tracking
service in ArcCatalog

1. Start ArcCatalog from the
Start menu or desktop icon.

2. Click the plus sign beside the
Tracking Connections folder
in the Catalog.

3. Double-click Add Tracking
Server.

The Add Tracking Server
dialog box opens, where you
can enter information about
the server and connection
name, as well as the servlet
path and port number.

4. Click in the Server Name text
box and type the name of the
machine that hosts the
Tracking Server.

5. Click in the Connection
Name text box and type the
name of the new connection.

6. Leave the Servlet Path
setting at the default, unless
your Tracking Server admin-
istrator tells you otherwise.

7. Click in the Port Number text
box and type the appropriate
value.

8. Click Test Connection to
make sure the information
you have entered is correct.

9. Click in the User Name text
box and type your system
username. �
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Enabling the server utility
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10. Click in the Password text
box and type your system
password.

11. Click OK.

The new connection appears
in ArcCatalog.


 �
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Setting
properties for
tracking
connections in
ArcCatalog
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Setting tracking server
connection properties

1. Start ArcCatalog from the
Start menu or desktop icon.

2. Click the plus sign beside the
Tracking Connections folder
in the Catalog.

3. Right-click on the tracking
connection you wish to edit
and click Connection
Properties.

The Tracking Server Connec-
tion Properties dialog box
opens.

Note: If you have not yet
created a tracking connection
in ArcCatalog, see the
previous section, ‘Connecting
to a message service in
ArcCatalog’.

4. Click in the Server Name text
box and make any necessary
changes.

5. Click in the Connection Name
text box and make any
necessary changes.

6. Click the button beside the
appropriate choice, to
include all services or select
specific services from the
connection.

7. Click OK.

The dialog box closes and
your new connection appears
in the Catalog tree and
Contents panel.

Tip

Specifying tracking
services
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Setting tracking service
properties

1. Start ArcCatalog from the
Start menu or desktop icon.

2. Click the plus sign beside the
Tracking Connections folder
in the Catalog.

3. Click the plus sign beside the
connection you have created.

A list of tracking services
appears below the connec-
tion in the Catalog tree.

4. Right-click one of the
services and click Properties.

The Tracking Service Proper-
ties dialog box opens,
including the name of the
service in the title bar,
displaying the General tab by
default.

5. Click the Auto Purge check
box on or off to determine
whether data will be thrown
away once a certain
threshold is reached.

6. Click the Threshold text box
and type a maximum number
of records to maintain in
memory.

7. Click in the Percent to Purge
text box and type a percent-
age of records to purge when
the Threshold is met.

8. Click the Purge Rule
dropdown arrow and choose
a rule from the list. �

Setting
properties for
tracking services
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Defining Auto Purge
Settings
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9. Click the Fields tab.

The Fields tab includes
information about the fields in
the tracking service.

10. Click any field to see its
properties.

Note: Because field
attributes are determined in
the Tracking Server, they are
not editable in this dialog
box. For more information on
defining real-time data
messages, see Using
ArcIMS Tracking Server.

11. Click the Actions tab.

The next section describes
the procedures for creating
and applying actions to real-
time data.
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Applying actions
to real-time data
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Applying a coordinate
conversion action to data
in ArcCatalog

1. Start ArcCatalog and
navigate to the real-time
connection you have set up
in the Tracking Connections
folder.

Note: For more information
on setting up a real-time
connection, see ‘Connecting
to a tracking service in
ArcCatalog’ in this chapter.

2. Right-click on the tracking
service whose coordinate
system you want to convert
and click Properties on the
context menu.

3. Click the Actions tab.

4. Click New Action.

The New Action dialog box
opens.

5. Click in the text box and type
a name for the action.

If you choose not to enter a
name, the default New
Action 1 will be used.

6. Click Coordinate Conversion
in the Type of Action to
Create panel.

7. Click OK.

The Coordinate Conversion
Action Parameters dialog
box opens. �

Tip

Changing action order
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8. Click Select to browse for the
desired spatial reference
system.

The New Spatial Reference
dialog box opens.

9. Click the button correspond-
ing to the method you wish to
use for the coordinate
conversion.

This example uses the Select
button to choose a pre-
defined coordinate system.

10. Navigate to the spatial
reference system you wish to
use and click Add.

The new spatial reference
system appears in the New
Spatial Reference dialog
box.

11. Click Next.

The second panel of the
New Spatial Reference
dialog box appears. �

�

�
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12. Check the values in the text
boxes and click Finish.

Note: If the values are
incorrect, you can click Back
to change previous options.

The new coordinate
reference appears in the
Coordinate Conversion
Action Parameters dialog
box.

13. Click the Geometry Column
dropdown arrow and choose
the field that contains spatial
reference information.

This field’s contents will be
converted to the new spatial
reference system you have
chosen.

14. Click OK.

The new action appears in
the Actions list panel, where
you can click it to read its
properties.

15. Click OK again to close the
Properties dialog box.
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Applying the filter action
to data in ArcCatalog

1. Start ArcCatalog and
navigate to the real-time
connection you have set up in
the Tracking Connections
folder.

For more information on
setting up a real-time
connection in ArcCatalog,
see Chapter 3, ‘Working with
temporal data’.

2. Right-click on the tracking
service whose features you
wish to filter and choose
Properties from the context
menu.

3. Click the Actions tab.

4. Click New Action.

The New Action dialog box
opens.

5. Click Filter in the Type of
Action to Create panel.

6. Click in the text box and type
a name for the action.

Note: If you choose not to
type a name, the default New
Action 1 will be used.

7. Click OK.

The Filter Action Parameters
dialog box opens. �

�
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8. Click the Type dropdown
arrow and choose Include or
Exclude.

Exclude will drop all features
in a dataset that meet the
criteria you set in the Query
Builder. Include will drop all
features that do not meet the
criteria.

9. Choose the appropriate type
of query you wish to build.

10. Depending on the type of
query you have chosen, you
can either click Query
Builder or the Ellipsis button
beside the Source text box.

11. Define your query as
needed.

Note: You will need to type a
unique value in the
Expression panel in the
Query Builder dialog box.

12. Click OK.
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Applying a custom VB
action in ArcMap

1. Right-click the real-time data
layer to which you want to
apply the VB action in the
table of contents and click
Properties.

2. Click the Actions tab.

3. Click New Action.

4. Click in the Name the Action
box and type a name for the
action.

Note: If you choose not to
enter a name, the default
New Action 1 will be used.

5. Click Visual Basic as the
Type of Action to Create.

6. Click OK.

The VB Action Parameters
dialog box opens.

7. Click the Project dropdown
arrow and choose Project or
Normal.

Note: A macro in the Normal
folder will affect all docu-
ments opened in ArcMap.

8. Click the Module dropdown
arrow and choose the
appropriate module for the
macro.

The default module name in
VBE is ThisDocument.

9. Click the Macro dropdown
arrow and choose the name of
the macro you wish to use. �

Applying custom
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10. Click the appropriate button
for the kind of query you
want to use.

11. Click Query Builder to load
or create a query for the
action.

All features meeting the
criteria defined in the query
will be affected by the VB
action you have created.

12. Click OK.

The new action appears in
the list panel on the Actions
tab.

13. Click OK to apply the new
action to the specified layer
and close the dialog box.

Note: Use a Visual Basic
action with caution. For
instance, if you used the
example macro on a real-
time data feed with
thousands of records, and
each of those records met
the trigger criteria for the
action, you would have to
acknowledge a Message Box
dialog box for each feature.
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Adding data from a real-
time tracking service

1. Start ArcMap from your Start
menu or desktop icon.

2. Open the desired .mxd file to
display a background map
for the new real-time tempo-
ral layer you will add.

3. Click the Add Data button on
the ArcMap Standard
toolbar—or click File and Add
Data.

4. Click the tracking service you
wish to add as a layer in the
Add Data window from the
Tracking Connections folder
and click Add.

Note: At this point you may
receive a warning message
about potentially incompat-
ible geographic projections.

The new layer appears in the
table of contents and features
begin to appear on the map.

5. Open the Playback Manager
to replay data stored in
system memory once real-
time data appears on the
map.

The playback window for
data stored in system
memory will start with the
time that data began stream-
ing in and end with the time
that you opened the Play-
back Manager.

Adding real-time
data in ArcMap
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